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1. SAFETY INSTRUCTIONS / DISCLAIMER
1.1	 Designated use 
The CorrTran AQUA is a compact, 4-20 mA corrosion transmitter used to detect general 
corrosion, localized corrosion, and conductance in the water quality industry. The transmitter 
measures the corrosion rate and pitting factor, giving the readout in mil/year or a 0-1 pitting 
factor, respectively. It also provides a conductance measurement. The readings are taken in 
real time and are updated approximately every 34 minutes. 

1.2	 Installation, commissioning, and operation 
CorrTran AQUA has been designed to operate safely in accordance with relevant technical 
and safety standards. If installed incorrectly or used for applications for which it is not 
intended, application-related dangers may arise. For this reason, the instrument must 
be installed, connected, operated, and maintained according to the instructions in this 
manual by appropriately trained personnel. This manual must be read, understood, and the 
instructions must be followed. Modifications and repairs to the device are permissible only 
when they are expressly approved in this manual. 

1.3	 Operational safety 
CorrTran AQUA cannot be used in a hazardous (classified) area. 

1.4	 Notes on safety conventions and symbols 
The following conventions are used to highlight safety-relevant or alternate operating 
procedures in this manual and are shown in the margin where appropriate.

Safety conventions

Symbol Meaning

Warning

A warning symbol highlights actions or procedures that, if not 
performed correctly, will lead to personal injury, a safety hazard, or 
destruction of the instrument.

Attention

An attention symbol highlights actions or procedures that, if not 
performed correctly, may lead to personal injury or incorrect functioning 
of the instrument.

Note

A note symbol highlights actions or procedures that, if not performed 
correctly, may indirectly affect operation or may lead to an instrument 
response which is not planned.

A terminal symbol indicates that a protective grounding (earth) 
terminal must be connected to earth ground prior to making any other 
connection to the equipment.
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1.5	 Disclaimer 
Metal Samples has no power, nor does it undertake to police or enforce, compliance with 
the contents of this manual or observance of the safety precautions set forth herein. Metal 
Samples does not certify, test, or inspect the installations of CorrTran AQUA for safety or 
other purposes. Metal Samples disclaims liability for any personal injury, property, or other 
damages of any nature whatsoever, whether special, indirect, consequential, or 
compensatory, directly or indirectly resulting from the publication, use of, or reliance upon 
this manual. Metal Samples makes no guaranty or warranty, express or implied, as to the 
accuracy or completeness of any information published in this manual, and disclaims and 
makes no warranty that the information in this manual will fulfill any particular purposes or 
needs. Metal Samples only warranty is set forth in the written Limited Warranty specifically 
provided by Metal Samples in connection with the purchase of the CorrTran AQUA.

2. IDENTIFICATION
2.1	 Device designation 
2.1.1	 Nameplates

joes
Rectangle
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2.1.2	 Model number

Model Number Description

CorrTran AQUA - MS2100L Base unit without local display

CorrTran AQUA with display - MS2150L Base unit with local display
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2.2	 Contents of delivery 

It is essential to follow the instructions concerning the unpacking, transport, 
and storage of this instrument given in section 2.3, “Incoming acceptance, 
transport, storage.” 

Unless ordered as components, the contents of delivery consist of: 

• Assembled transmitter

• 12’ cable (for probe)

• Instruction manual (this document)

2.3	 Incoming acceptance, transport, storage 
2.3.1	 Incoming acceptance 
Check the packing and contents for any signs of damage. Check the shipment to ensure 
that all parts have been included and to verify that the shipment matches your order. 

2.3.2	 Transport 
Protect the transmitter electrodes from damage. Do not attempt to carry the transmitter by 
its electrodes. 

2.3.3	 Storage 
Always pack the instrument for storage or transport to protect it against impact. The original 
packing material provides the optimum protection for the device. The permissible storage 
temperature is -40 °F to +176 °F (-40 °C to +80 °C).

2.4	 Certificates and approvals 
The CorrTran AQUA is designed to meet relevant safety requirements. It has been fully 
tested to ensure that it is in safe operating condition. The instrument complies with the 
applicable regulations in accordance with known standards. 

2.5	 Registered trademarks 
HART® 
Registered trademark of HART Communication Foundation, Austin, USA 

Viton® 
Registered trademark of the company E.I. Du Pont de Nemours & Co., Wilmington, USA 

2.6	 Patents 
This instrument is protected by one or more patents registered in the US Patent Office.

Attention
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3. INSTALLATION AND MOUNTING
3.1	 Dimensions

Ø14.8

48
.2

Ø10

Ø10

Ø10.8

M12x1
external 
threads

Ø10.8

Ø14.8

45.3

M12x1
internal
threads

Probe cable

Probe	
Cable Length:	
3.6 m (12’)





4 - 20 mA PROBE

5.
4"

3.
4"

7.1"

7.1"

joes
Line

joes
Line

joes
Line

joes
Line

joes
Line

joes
Line

joes
Sticky Note
Unmarked set by joes

joes
Line

joes
Line

joes
Line

joes
Line

joes
Line

joes
Line



CorrTran AQUA Corrosion Monitor

8

Figure 1.  CMC Probe Installation Figure 2.  CMC Probe Installation

3.2	 Mounting safety procedures and hints 
 


 

The transmitter should not be mounted in a pipe drop since the corrosive 
liquid may not be in full contact with the electrodes as shown in Figure 1. 

CorrTran AQUA should be mounted in the riser of a pipe near an elbow where 
the velocity is the highest. In general, CorrTran AQUA should be mounted in 
pipes or tanks at locations of highest liquid velocity and constant immersion, 
shown in Figure 2. For velocities greater than 20 fps, the protruding finger 
electrodes must be protected. As noted above, high fluid velocities can also 
cause unwanted turbulence in the pipe due to the extension of the probe. 

4 - 20 mA PROBE

Attention

Warning





4 - 20 mA PROBE

OK!

15 diameters downstream
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The CorrTran AQUA probe can be located at any point on the pipeline but should always be 
immersed in the corrosive material as shown in Figure 3. 

Figure 3.  Correct CorrTran AQUA Pipeline Position 

A tee in the condensate return line (Figure 4) is a good location to mount the CorrTran 
AQUA probe

Figure 4.  CorrTran AQUA Located in Tee





4 - 20 mA PROBE





4 - 20 mA PROBE

4 - 20 mA PROBE

Note: The line must be full at all times and electrodes must be located in 
the bottom half of the line. Electrodes must be covered at all times.
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The CorrTran AQUA probe should be located downstream of a control valve for best 
performance and can also be located in the deadleg portion of a by-pass. Note that 
the probe located in the by-pass leg should be mounted in front of the valve for best 
performance. See Figure 5. This guarantees that the electrodes will always be immersed in 
the corrosive material. 

Figure 5.  CorrTran AQUA Located in Bypass Loop 
Top View

Installing separate CorrTran AQUA probes with different electrode materials on the 
suction side of the pump will ensure monitoring of the pump impeller and the pipe 
as shown in Figure 6. There should be a minimum separation distance of 50 cm 
(19.7”) between probes.

Figure 6.  CorrTran AQUA Probes Mounted With Different Electrodes 





4 - 20 mA PROBE





4 - 20 mA PROBE

Note

15 diameters

Bypass Valve Bypass Valve

Control Valve

4 - 20 mA PROBE
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In addition to pipes, a condensate flash tank, shown in Figure 7, is also a good application. 

Figure 7.  CorrTran AQUA Installed in a Condensate Flash Tank 

The CorrTran AQUA probe should NOT be located in the blow down of a Y-strainer as 
shown in Figure 8. Nor should it be located in the discharge side of the basket strainer as 
shown in Figure 9.

4 - 20 mA PROBE





4 - 20 mA PROBE





4 - 20 m
A

PRO
BE

Figure 8.  Probe Mounted in Y-Strainer Figure 9.  Probe Mounted in Basket Strainer

CorrTran AQUA may be implemented in a rack in place of traditional metal-loss coupon 
monitoring and can be installed in an existing coupon rack. In this case, the CorrTran AQUA 
probes should be inserted in place of the coupon holder ports as shown in Figure 10.

Figure 10.  CorrTran AQUA Mounted in a Coupon Rack 





4 - 20 mA PROBE

Direction of flow 
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3.3 Installation instructions 
 

A trained specialist must perform the necessary installation and commissioning 
of CorrTran AQUA. Recognized rules of the technology and setup requirements 
must be maintained both during and after installation. Safety requirements 
must be observed during all installation steps. 

If the pipe or vessel into which the CorrTran AQUA  is to be inserted is under pressure 
and/or contains any hazardous substance, such as steam, caustic solutions, acids, toxins 
or other substances specified by OSHA as physical or health hazards, the pipe or vessel 
must first be depressurized, any hazardous substance purged therefrom, and appropriate 
lockout/tagout procedures observed in accordance with Section 1910.147 of the OSHA 
Regulations, before CorrTran AQUA can be installed. Failure to follow these procedures 
may result in serious injury or death.

CorrTran AQUA  consists of three basic components: 

• Transmitter: A transmitter housing contains the electronics and provides the 4-20 mA with
HART output signal. 

• Probe: The remote mount probe is supplied with a 12’ cable. 

• Electrodes: Either finger electrodes or electrodes flush to the probe end are used. 
For accurate measurements, use electrodes of the same alloy as the metal being
investigated.

 
 

 


Typically, carbon steel electrodes are inspected every 90 to 180 days and yellow 
metal electrodes (copper and copper alloy) are inspected every 180 to 360 days. It’s not 
just the general corrosion rate, it’s also fouling or bridging that occurs that may result in 
false readings. When installed in corrosion coupon racks, the probes should be inspected 
whenever a corrosion coupon is removed and replaced. If the electrodes are fouled, they 
should either be carefully cleaned or replaced. 

Figure 12.  Electrodes and Viton Gaskets

Metal Samples recommends that the person installing the electrodes wear a plastic 
glove of the type used in medical offices or the type used by food preparers. It is 
important not to touch the electrodes with your bare hands.

Warning

Electrodes Viton Gaskets

Note
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3.3.3 Probe connection	

Connect the transmitter to the probe using the supplied probe cable. 

Tighten the connectors finger-tight to ensure a good, weatherproof connection.

Figure 13.  Probe Connection





4 - 20 mA PROBE
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4. STARTUP AND WIRING
4.1 Startup
The measurement cycle of CorrTran AQUA is 34 minutes. When power is first applied to the 
unit, the output will read 4 mA for 34 minutes.  After the first reading, the output should go to 
higher than 4 mA, depending on the corrosion rate.

4.1.1		 Quick wiring guide 
Field installable V1-G connector (117051), Figure 14.

Figure 14.  Transmitter Wiring

4.2	 HART introduction 
 






4.3	 Wiring with HART 
If you are using CorrTran MV with a non-HART compatible I/O of data collection device, the 	
KFD2-HLC-Ex1.D, HART Loop Converter, can integrate the three CorrTran AQUA variables 
into separate, independent 4-20 mA outputs. 

joes
Text Box
(> 250 Ω)
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Please observe the following guidelines: 

• Always use a grounded power supply (on the AC side). 

• Ensure that the I/O card is isolated from ground. 

Figure 15.  Connecting to analog auxiliary port on controller

Figure 16.  Connecting with a HART modem or handheld

4.4	 Post-installation check 
After wiring the transmitter and connecting the probes, perform the following checks: 

• Is the probe secure and tightened to specified torque? (See section 3.4.3.)

• Have the electrodes been cleaned? (See section 3.4.2.)

• Is the terminal assignment correct? (See section 4.1.)

• Is the housing cover screwed tight?

4-20 mA

Controller

4-20 mA

HART handheld

PACTware

250 Ω

HART modem

DC power 
supply unit 

or 
Controller
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5. THE HART MODEM
5.1 HART modem general description 
As an optional accessory, a MicroLink 101-0027 USB HART® protocol modem can be ordered 
with the CorrTran AQUA. The modem provides the hardware interface between Highway 
Addressable Remote Transducer devices (HART) and a Windows® PC with a USB interface. 
MicroLink is used for commissioning, diagnostics, monitoring, and testing HART field devices. 

Virtual serial port drivers allow the USB MicroLink to appear as an RS-232 com port to 
Windows and your HART software. A rugged design makes MicroLink an ideal choice for field 
engineers and technicians who service HART devices in an industrial environment. Microlink 
is compatible with all registered HART devices and all leading HART configuration and 
monitoring software. 

5.2 Driver pre-installation
 The USB drivers should be installed before the MicroLink HART modem is connected to the 
PC’s USB port.  After the drivers are installed, Windows will automatically detect the modem 
when it is connected to the USB port and complete the setup. 

Install USB driver before 
connec  ng to the USB port.

Important! To pre-install the drivers, run Msetup.exe from 
the included CD. The CD will auto-run this file if 
the Windows autorun feature is enabled for your 
CD drive.

Figure 17. Msetup.exe  HART Protocol Setup Utility

Click the Install button in the 101-0027 window to pre-install the USB drivers. The driver 
installer will guide you through the setup process. Installers can also be run manually from 
the CD, without running Msetup, by running \x86\dpinst.exe file for 32 bit operating 
systems or x\64\dpinst.exe for 64 bit operating systems.

Don’t have a CD drive? 
Download the HART Protocol CD image from www.microflx.com/pages/support. 
Running the file will self-extract the compressed files and start the Msetup.exe HART 
Protocol Setup Utility.

www.microflx.com/pages/support
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5.3  Driver inf file - manually installed 
To manually install the driver inf file:
1. Connect the Converter to the USB port.
2. Open the Windows Device Manager.
3. The New Device Wizard will have added the converter under Ports (COM & LPT)

and will appear as MicroLink HART Protocol Modem (COMx). Right click the device
and select Update Driver Software...

4. Choose to Browse for the driver software and browse to the CD or the location of
the MxHART.inf file.

5. Follow the wizard prompts to complete the driver setup.

5.4  Uninstalling the USB drivers
If needed, use Windows Device Manager to uninstall the driver from your system.  
With the modem connected to the USB port, locate the MicroLink modem in the 
Device Manager hardware tree under Ports (COM & LPT). Right click on MicroLink 
HART Protocol Modem and select Uninstall from the pop-up menu.  When the 
process has finished, unplug the modem from the USB port.

5.5  Finding the assigned COM port number 
When Windows installed the serial port driver the next available COM port number 
was assigned to the converter. The software you use with the converter must be set to 
use the same COM port number. To find the number assigned to your converter run 
Msetup.exe from the CD and click the Com Port List... button to show a list of found 
devices and assigned COM port numbers. 

Figure 18. Com Port List view. MicroLink modem is assigned to COM 7

To use the list...
Unplug the modem from the USB port and it 
will be removed from the Com Port List. 

Plug the modem into the USB port and it will 
be added to the Com Port List.

Set your HART software to use the same COM 
number assigned to your modem.
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The assigned serial COM port 
number can be changed to any 
available COM port using Windows 
Device Manager.  

Expand Ports (COM & LPT) in the 
list to see which port the converter 
is assigned to. 

Right click MicroLink HART 
Protocol Modem and select 
Properties from the pop-up menu. 

On the Port Settings tab, click 
Advanced. 

Drop down the COM Port Number 
list and select the desired port 
number.  

5.6  Using Windows device manager 
The assigned COM port number can be found using Windows Device Manager.  
Open Device Manager and select View > Devices by Type.  
You may need to expand the Device Manager tree under Ports (COM and LPT) 
to see the converter. 
In the example shown below, the modem is assigned to COM 7. 

Figure 19. Windows Device Manager

Click OK to use the new port number and close the window.

Unplug the MicroLink modem from the USB port and then reconnect it to  
allow Windows® to update the USB device parameters.

Click OK again to close the Properties window.
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Make sure your HART soŌ ware is set to use the same serial COM port number 
that the MicroLink modem is assigned to.  

There are no hardware se ƫ ngs required by the MicroLink modem and modem 
power is provided by the USB port. All other se ƫ ngs, such as BAUD rate and 
parity, are taken care of by your HART soŌ ware.

Connect the two mini-clips to the HART device or HART loop.  MicroLink 
provides electrical isolaƟ on between the HART loop and the PC.  It is safe to 
ignore grounding and polarity issues when making the HART connecƟ ons.  

The HART protocol requires a loop resistance of 230 to 600 ohms, typically 
250 ohms.  Refer to your equipment installaƟ on instrucƟ ons for details on 
connecƟ ng a HART protocol modem or confi guraƟ on device to the loop.

LOOP
POWER
SUPPLY

HART
DEVICE250Ω

COMPUTER
Microflex

LOOP
POWER
SUPPLY

HART
DEVICE250Ω

COMPUTER
Microflex

MicroLink HART modem connected 
across the HART loop resistor. 

MicroLink HART modem connected 
across the HART device. 

Figure 20. Two common methods for connecting the HART modem to a loop powered device. 

5.7  Software setup

5.8  Connecting to the HART device
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Controls and Indicators Dip Switch Settings

Two Point Digital Scaling and Calibration - Quick Reference Guide

Digit/Descriptor Display Lock/
Frequency

Default Setting
When set to ON

displays [Lock] when
any button is pressed

Effect on Display

F

C

1
2

1
2

1
2

1
2

ON

ON

ON

ON

Dummy Zero

1
2

ONOFF
50

ON
60

Display Lock

Rejection Filter (Hz)

Default
Setting

When set to ON
displays [Lock] when
any button is pressed

F

C
Dummy
Zero

OFF
50

ON
60

Display Lock

Rejection
Filter (Hz)

Rear View of the Meter
UP ARROW

BUTTON

DOWN 
ARROW
BUTTON

PROGRAM BUTTON: This button is used to move from one
program step to the next.When pressed simultaneously with the
UP ARROW button, the Programming Mode is entered.
UP ARROW BUTTON: Increases the value of the displayed
parameter.
DOWN ARROW BUTTON: Decreases the value of the dis-
played parameter.
NOTE: When the display lock switch is on and any button is
pressed, the display will show only [Lock] momentarily as
shown above and then return to the normal operational display.

PROGRAM
BUTTON P

Enter the
Calibration Mode Enter the

Calibration Mode

Operational Display

Operational Display

Operational Display

Select [cAL on]

TEXMATE

Prog.

Set DIP switch
to lock OFF

TEXMATE

Prog.

Set the LOW input value
and enter the HIGH Input

[hi in] Mode

Apply the 4 mA
LOW input
calibration signal
to the meter.

TEXMATE

Prog.

Enter the LOW Input
[Lo in] Mode

If display shows [cALErr] 
the calibration has been canceled
and the previously calibrated scale

factors are retained in memory.
(See page 2, para 5)

TEXMATE

Prog.

TEXMATE

Prog.

TEXMATE

Prog.

Pass Calibration Mode
and enter Decimal Point

Setting Mode

1
2

ON

Set DIP Switch
to Lock On

1
2

ON

Set DIP switch
to lock ON

1
2

ON

Set DIP switch
to lock OFF

1
2

ON

OR

TEXMATE

Prog.

OR
Press

1

TEXMATE

Prog.

Set the HIGH input value and
return to Operational Display

Apply the 20 mA
HIGH input
calibration signal
to the meter.

Press
1

TEXMATE

Prog.

Press
1

Press
1

TEXMATE

Prog.

Adjust the decimal point
to the desired position

Press
1

Step 1

Two Point Calibration and Scaling
Example: 4 to 20 mA input to read 0 to 20,000

Decimal Point Setting

Step 2

Step 3

Step 4

Step 5

Step 7

Step 2

Step 3

Step 4

Set the decimal point position
and return to Operational Display

Press
at same

time
Press

at same
time

Operational Display
TEXMATE

Prog.

Step 1

Press
at same

time

Press
at same

time

TEXMATE

Prog.

Adjust display to the
desired reading for

HIGH input

TEXMATE

Prog.

OR

Any value between
-19,999 and 30,000
may be selected. 
Reverse scaling

is accepted.

TEXMATE

Prog.

TEXMATE

Prog.

Adjust display to desired
reading for LOW input

OR

Step 6

Max difference
between [hi in] &

[Lo in] display
values selected
cannot exceed
32,000 counts.

If the input signal is dis-
connected after Step 5, the

[Lo in] values are saved, and
the meter automatically

returns to the [hi in] mode when
signal power is re-applied.

Maximum positive reading is
30,000 & maximum negative
reading is -19,999. Maximum
display span is 50,000 counts.

6. CONFIGURING THE DISPLAY (if equipped)

20
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7. CorrTranMV EVALUATION TOOL
7.1	 CorrTranMV Evaluation Tool introduction
CorrTran MV Evaluation Tool is supplied with every CorrTran AQUA. (**The CorrTran MV 
Evaluation Tool is functionally equivalent to the CorrTran AQUA.) It provides an easy-to-
use setup feature for CorrTran AQUA plus the ability to store AQUA data in ASCII files that 
can be imported into your favorite analysis package.

The unit may also be programmed using Metal Samples' PACTware programming 
environment. Please contact the factory for more information on PACTware.

7.2	 Establishing communication with the CorrTranMV Evaluation Tool
• To establish communication between your CorrTran AQUA using the CorrTran MV

Evaluation Tool, you must first ensure that your CorrTran AQUA and HART modem
are connected as shown in section 4.3, the device drivers for your HART modem have 
been successfully installed, and you have the CorrTran MV Evaluation Tool software 
installed on you computer. 

• Open CorrTran MV Evaluation Tool. Figure 21 shows the main (default) screen you will
see when opening the program.

Figure 21.  CorrTranMV Evaluation Tool Main (default) Screen

7.2.1	 Assigning the HART modem to the correct com port 
When first launched, the CorrTran MV Evaluation Tool defaults to Com1 and will very likely 
need to be changed unless you are using a RS232 HART modem. 

USB connections will show up as com ports in the CorrTran MV Evaluation Tool 
environment.  If you are not sure what com port your modem is using, go to your computer’s 
device manager by opening the following windows: 

• ‘Control panel’ > ‘System’ > ‘Hardware’ > ‘Device Manager’

• Expand the ‘Ports (COM & LPT)’ to find out which com port is being used by the USB
modem, as seen in Figure 22.

21
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Figure 22.  Device Manager Ports (COM & LPT)

Now that you know the appropriate Com Port for your HART modem:

• Select ‘Communication’ > ‘Com Port’ from the tool bar and select the Com Port that
has been assigned to your HART Modem.

7.2.2	 Connection to the CorrTran AQUA
• Select ‘Communication’ > ‘Open” from the tool.  The ‘Connect’ button will become

available as seen in Figure 23.

• Press the ‘Connect’ button to establish communication between the CorrTran AQUA and
CorrTran MV Evaluation Tool.  If everything has been done properly all the fields will
be populated as seen in Figure 24.

Figure 23.  After Communication Opened

22
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Figure 24.  After Successfully Connected

At the top of the screen the following read only information is displayed:

• Device revision
• Device ID
• Hardware revision
• Software revision

7.3	 CorrTran MV Evaluation Tool capabilities 
Once a connection has been established, information from the CorrTran AQUA transmitter 
can be gathered. 

7.3.1	 Process data tabs 
The process data tab, seen in Figures 23 and 24, allows you to view the most recent 
outputs from the CorrTran AQUA.

• Cycle:  Number of corrosion measurement cycles completed on CorrTran AQUA
transmitter since the device was last reset. See Section 7.3.4 for information on
resetting the number of cycles.

• Update – Pressing this button populates all categories on the process data tab with the
current CorrTran AQUA output values.

• Cyclic – Pressing this button enables the CorrTran MV Evaluation Tool to update the
values on the process data tab every measurement cycle.  When this button is
engaged the time remaining in the current cycle is displayed at the bottom of the 
screen.

• Log On/Off – When checked it enables the data logging capabilities of the CorrTran
MV Evaluation Tool.  You will need to place a checkmark by each data point you
wish to log.  Figure 27 provides data logging of every possible data point in a cyclical 
manner.  For more information on the logging capabilities of the CorrTran MV 
Evaluation Tool see section 7.3.4.
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A data set can be manually added to the log file by clicking the update button, 
or logging can be made automatic for every measurement cycle by having cyclic 
selected.

• Gen. Corr.:  Current general corrosion reading and its measurement units.

• Loc. Corr.:  Current localized corrosion reading.

• LC. Avg:  The average localized corrosion value.  This value is averaged until the Cycles/
Avg is reset or the CorrTran AQUA is reset to factory default. See Section 7.3.4 for
information on Cycles/Avg reset and resetting to factory default.

• Sol. Cond.:  Current solution conductance measure in Siemens (S)

• B-Value:  Current measured Stern-Geary value (Bharm)

• Lp Current:  Current loop current

Figure 25.  Log On For All Data Points, Cyclic Mode

7.3.2	 Online parameters: process variables 
The device Setting tab, seen in Figure 26, allows you to configure the following parameters:

• PV Preferences:  Allows you to configure the Primary Variable (PV) as either general or
localized corrosion.

Note

If general corrosion is selected as the Primary Variable then localized corrosion 
becomes the secondary. If localized corrosion is selected as the Primary Variable 
then general corrosion becomes the Secondary Variable. The Tertiary Variable 
(TV) is always conductance and cannot be changed.  

Note
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• PV Units, LRV, URV: allows you to configure the PV units and range, when general
corrosion is assigned as the PV. The default values on the CorrTran AQUA are in units
of mpy with a range of 0…40 mpy. The full range of CorrTran AQUA is 0…1000 mpy 
(0…25 mmpy).  

Note

When localized corrosion is assigned as the PV, no units or range are selectable 
because localized corrosion is unitless and is on a scale from 0 to 1, with 0 being 
no localized corrosion and 1 being very high.)

• Alarm Mode:  Controls the settings for an alarm that activates when the PV corrosion
rate goes beyond the URV.  The default is Auto, and the options are as follows:

• Auto – Output goes to 22.5 mA and resets automatically

• Manual – Output goes to 22.5 mA and resets manually

• Off – Alarm is turned off

• B value:  Refers to the B value or Stern-Geary voltage, which is defaulted to 25.6 mV.
B User is only relevant in LPR only mode.  This value does not normally need to be
changed.

• A Elect Area:  Allows you to change the electrode area, which is required for the
corrosion calculation.  The surface area is defaulted to 4.75 cm2 for the finger type
electrodes.  Flush mount electrodes are defaulted to 0.316 cm2.

• �K Probe Const: refers to the K probe constant, or corrosion constant K. This value is
dependent on the pipe’s metal properties and is required for the calculation process. 

The default is 11597.63 mm * cm2

year * cm2

K = 3270.22 * (atomic mass of metal in grams)
(# of electrons in the corrosion reaction) * (density in g/cm2)

See Electrode Material Guide Table in the Appendix for factory calculated K values of 
common electrode materials.

• Measurement Mode:  Certain corrosion measurements can be turned off to give a faster
response if not required for the calculation.  The two variables that can be switched off
are general corrosion (GC) and localized corrosion (LC).  Conductance is required for 
both corrosion types and cannot be turned off.  If all three are used, the default is GC 
+ LC + Cond.  The three possible configurations and cycle times are:

• GC + LC + Con – General, Localized, Conductivity: 21 min. cycle

• GC + Con – General, Conductivity: 4 min. cycle

• LC + Con – Localized, Conductivity: 17 min. cycle
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• Device Mode:  This determines the way the general corrosion calculation is performed
by the CorrTran AQUA.

• Normal (HDA/LPR) – A process-specific Stern-Geary voltage (Bharm) is
calculated with every measurement cycle through HDA.  This value is then
implemented in the LPR corrosion rate calculation.  This is the default setting
and should be left intact to maintain the best accuracy.

• LPR only – A user defined Stern-Geary voltage (‘B User’) is specified and
used for all LPR corrosion rate calculations. This is how CorrTran AQUA is
configured.

• Device Settings Tab Buttons:  These buttons are found at the bottom of the Device
Status Tab page.

• Reset Alarm - This button is used to reset the alarm when operating the
CorrTran AQUA in Manual Alarm Mode.

• Read Values - Pressing this button populates all categories on the device
settings tab with the current values programmed on the CorrTran AQUA
transmitter.

• Write Values - Pressing this button programs the CorrTran AQUA transmitter to
all settings currently displayed on the Device Settings Tab.

Figure 26.  Device Setting Tab
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 7.3.3	 Device status tab  
The Device Status tab, seen in Figure 27, allows you to view any system errors or faults the 
CorrTran AQUA may be experiencing. Errors or faults appear as check marks next to their 
descriptor.

Figure 27.  Device Status Tab Device

The cause of each error or fault is described in Section 12, Troubleshooting, Table 2. 

• Device Settings tab buttons: These buttons are found at the bottom of the Device
Status tab page

• Reset config changed flag: Clears a check next to configuration changed

• Update Status: Updates the device status tab with the most recent system errors or
faults

7.3.4	 Tools tab 
The Tools tab, seen in Figure 28, allows you to log corrosion data, extract previously 
collected corrosion data, and access the resetting features of CorrTran AQUA.
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Figure 28.  Tools Tab

• Data Logging:  The Select File button allows you to set the location for and the name
of the Log File where data is stored when the Log function is enabled on the Process
Data tab, see section 6.3.1.  Data is saved in one of two ways:

• Append – Data is added to previously logged data
• Overwrite – Data replaces previously logged data

• History File:  The Select File button allows you to set the location for and the name
of the History File where data is stored when Get History button is pressed.  Data is
retrieved and saved in one of two ways:

• Append – Data is added to previously retrieved data
• Overwrite – Data replaces previously retrieved data

• View Files:  Clicking the Log File button or the History File button will open their
respective files.

• Initial Bavg-Value:  The default setting is Actual Average and results are typically best if
left as is.

• Num of Cycles to read:  The CorrTran AQUA stores data from its last 300 cycles in its
internal memory.  By pressing the Get History button the CorrTran AQUA Evaluation
Tool extracts the data for a user defined number of cycles (1 to 300) and appends or 
overwrites it to the History File.

• Loop Current:  When using HART communication for data collection, the 4-20 mA
signal is no longer important.  You can choose to set the loop current to a constant
fixed value.  If you get an error for Electrode Balance out of Range on the Device 
Status tab, setting the loop current to a high mA fixed value should clear this.  If you 
want the loop current to change between 4-20 mA as the primary variable changes 
select Actual PV Value (normal) which is the default setting.

• Special Features:

• Reset Cycles/Avg – Resets the number of cycles to 0, clears the internal
memory of its historic data, and resets the LC. Avg. calculation.

• Reset Device – Cycles power to the CorrTran AQUA.
• Factory Default – Has the same functions of the Reset Cycles/Avg button, and

resets all settings to the factory default.
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8. TRANSFERING PROCESS DATA TO EXCEL
The CorrTran MV Evaluation Tool allows you to view CorrTran AQUA process data in 
two ways. You can use the logging function to set up a running log file that will record the 
corrosion values you select. The second method involves retrieving data from the internal 
memory, which stores data from the last 300 cycles creating a history file. Both the Log File 
and History File are saved as .txt documents. To transfer this data into Excel, click on the 
view log file or history file button on the tools tab and the appropriate .txt file will open as 
seen in Figure 29 (for this example, the log file is used). 

Figure 29.  CorrTran MV Log File

• Select ‘Edit’ > ‘Select All’ from the tool bar to select all the data in the log file.

• Select ‘Edit’ > ‘Copy’ from the tool bar to copy all the data in the log file.

• Open a new Excel work book and select cell A1.

• Select ‘Edit’ > ‘Paste’ from the Excel tool bar to transfer all the log data to Excel.  At this
point the data is all in column A as a text format and will appear as seen in Figure 30.
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Figure 30.  CorrTran MV Log File

• Select all of column A as seen in Figure 30, Select ‘Data’ > ‘Text to Columns…’ from the
tool bar and the screen in Figure 31 will appear.

Figure 31.  Text to Columns

• Select Fixed width as seen in Figure 31 and then press Finish. The text data has now
been transposed to the proper columns with the proper headings as seen in Figure 32. 
Adjust the column sizes to accommodate the data as needed.  
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Figure 32.  Properly Sorted Data

• You can now trend and analyze the log data as needed.  Figure 33 is an example of how
you can plot general corrosion, localized corrosion, and conductance over time.

Figure 33.  Example Log Data Graph
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9. CHANGING CORRTRAN AQUA OPERATING MODE TO
REDUCE THE EXCITATION FREQUENCY (Factory Default
Setting for CorrTran AQUA)

The functionality here is that under certain conditions the CorrTran can read values that are, 
typically, much higher than expected. This may be due to a high-capacitance effect on the 
electrodes caused by filming inhibitors. 

To see if this effect is present, it is necessary to reduce the sine wave frequency in order to 
eliminate the capacitance effect. Operating the unit in Enhanced Mode 1 or 2 facilitates the 
lower frequency sine wave. If the effect is not present, there will be little change between 
standard and enhanced modes. If there is a big reduction in the corrosion rate, then the 
capacitance effect is real and Enhanced Mode 1 or 2 should be set permanently for that 
application. Determining which Enhanced Mode to operate in is determined empirically.

Figure 34 is for the CorrTran EC. It is identical on the CorrTran MV or CorrTran AQUA.  
Note: CorrTran AQUA is shipped from the factory defaulted to this setting.

1.	 Connect the CorrTran Evaluation Tool. Establish Communication.

2.	On the Tools Tab, under LPR/HDA Performance select Enhanced Mode 1. Press the
Set button to send the setup to the unit. If the corrosion rate does not change after 1-2
hours of operation, there is no capacitance effect. Return the unit to Standard Mode.

3.	 If there is a reduction in corrosion rate, try Enhanced Mode 2. If a reduction in corrosion rate
is still produced, use Enhanced Mode 2 otherwise return setting to Enhanced Mode 1.

Figure 34.  Enhanced Mode

Disconnect the Evaluation Tool and reconnect your DCA. Note: The evaluation time for a 
complete cycle changes from 21 minutes in Standard Mode to approximately 37 minutes 
when running Enhanced Mode 2. It is between the two for Enhanced Mode 1. This is the 
reason to back down to Enhanced Mode 1 if Enhanced Mode 2 does not produce an 
additional reduction in corrosion rate.
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10. REPLACEMENT PARTS AND ACCESSORIES
10.1	CorrTran AQUA parts 
Please submit the serial tag number on the nameplate when ordering replacement parts for 
CorrTran AQUA. 

If the pipe or vessel into which the CorrTran AQUA is to be inserted is under 
pressure and/or contains any hazardous substance, such as steam, caustic 
solutions, acids, toxins or other substances specified by OSHA as physical 
or health hazards, the pipe or vessel must first be depressurized and any 
hazardous substance purged there from, and appropriate lockout/tagout 
procedures observed in accordance with Section 1910.147 of the OSHA 
Regulations, before CorrTran AQUA can be removed or the electrodes 
replaced. Failure to follow these procedures may result in serious injury 
or death.

ertificates

Warning

10.2 Accessories

ET915548 HART modem, HART to USB interface
For direct connection to your PC

ET1804 HART Loop Converter
Converts HART signal to 3 separate 4 ... 20 mA outputs
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11. SYSTEM SPECS
Application
The	CorrTran	AQUA	performs	continuous	(electro-chemical)	corrosion	measurement	of	
liquids	and	gasses.	

Function and System Design
Measuring Principle:	The CorrTran AQUA utilizes state-of-the-art algorithms and data 
analysis techniques to accurately measure general corrosion rate and pitting. To improve 
the performance of the industry accepted Linear Polarization Resistance (LPR) technique 
the Harmonic Distortion Analysis (HDA) is used to calculate and update a process 
specific Stern-Geary variable (Bharm) every measurement cycle.  To further enhance 
the performance, an application-specific Stern-Geary variable (B-value) is calculated 
and updated every measuring cycle.  There is no need to manually update the B-value 
because of process changes.  During the measurement cycle, CorrTran AQUA also 
performs an automated Electrochemical Noise (ECN) measurement which provides a 
localized corrosion (pitting) measurement.  At the completion of each measurement cycle, 
the respective corrosion rate and pitting value in the form of a 4-20 mA/HART signal is 
produced and made available to plant personnel.

Equipment Architecture
See Section 4.3 Wiring with HART.
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Technical data
Input

Measured Variable • �General corrosion: Electro-chemical corrosion that proceeds more or 
less uniformly over the surface of the material exposed to the corrosive
environment. 

• �Localized corrosion (pitting): Electro-chemical corrosion that occurs at
discrete sites on the material exposed to the corrosive environment. 

• �Conductance: The reciprocal of the solution resistance. It is a measure 
of how easily electricity flows along a certain path through an electrical
element.

Measuring Range • �General corrosion: 0 ... 1000 mpy (0 ... 25 mmpy),
0 ... 40 mpy (0 ... 1 mmpy) default value 

• �Localized corrosion (pitting): Unitless number from 0 ... 1, with 0 being
no localized corrosion and 1 being very high. 

• �Conductance: Not adjustable. Measured in Siemens. 

Output

Output Signal 4-20 mA with HART protocol, 2-wire

Signal on Alarm Error information can be accessed via the following interfaces: 	
• Current output, 22.5 mA
• Digital interface

Auxiliary Energy

Load HART Minimum load for HART communication: 250 Ω

Cable Entry Industry standard V1 (M12 connector)

Supply Voltage 11-30 VDC witout display	
15-30 VDC with optional display

Rated Operating Voltage 11 VDC min at max loop current

Connectable Load Max. load at 24 VDC: 575 Ω with alarm / 650 Ω without alarm

B-Value (Start-up) 25.6 mV

Performance 
Characteristics

Reference Operating 
Conditions

• Temperature: -40 °C to +70 °C (-40 °F to +158 °F)

• Solution conductance: Min 4 μS

• General corrosion rate: 0 ... 1000 mpy (0 ... 25 mmpy)

Accuracy • Voltage measurement and electrode excitation: <0.02%

• Current measurement: <0.1%
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Technical data (continued)
Operating Conditions

Operating Conditions

Installation Instructions See Section 3.4 Installation Instructions

Environment

�Ambient Temperature 
Range

Ambient temperature for the transmitter: 

• With display: -10 °C to +50 °C (-14 °F to +58 °F)

• Without display: -40 °C to +70 °C (-40 °F to +158 °F)

�Storage Temperature

�Degree of Protection

Mechanical Construction

Design, Dimensions See Section 3.1 Dimensions

Weight Approx. 500 g (16.1 oz), transmitter housing

Material • Housing: ABS 

Human Interface 

Operation	Concept See Section 4.3 Wiring with HART. 	
See Section 5 Configuration and Commissioning

Certificates and 
Approvals

Patents U.S. patents: 7,239,156; 7,245,132; 7,265,559; 7,282,928

36

joes
Rectangle

joes
Rectangle



CorrTran AQUA Corrosion Monitor

12. TROUBLESHOOTING
 



Symptom Cause/Procedures Solution

No 4-20 mA output Check voltage and compare it with the 
specifications on the nameplate. Connect the correct voltage

Measuring correct 
voltage but unit does 
not respond

Check polarity on the terminals. See section 4.1: Quick Wiring 
Guide

HART communication 
does not function

The communication resistor is not 
installed properly. See chapter 4.3: Wiring with HART

Table 1.  CorrTran AQUA Basic Troubleshooting Guide

Device Status 
Codes

Description Troubleshooting

PV out of limits The primary variable has exceeded 
either the LRV or URV.

This can only happen if General 
Corrosion is assigned to the PV and 
the ranges are not set properly. Extend 
the range values to include current 
data point. See section 6.3 for more 
information.

SV or TV out of 
limits

The secondary or tertiary variable has 
exceeded either the LRV or URV

This can only happen if General 
Corrosion is assigned to the SV and 
the ranges are not set properly. Extend 
the range values to include current 
data point. See section 6.3 for more 
information. The TV cannot be out of 
limits because it has no limits.

Analog output 
saturated

The analog output has reached either 
its minimum or maximum

This can only happen if the alarm mode 
is off and the PV exceeds its LRV or 
URV.

Analog output 
fixed

The analog output signal has been set 
to a fixed mA value.

This is a result of setting the Loop 
Current to a fixed value on the 
tools tab. See section 6.3 for more 
information.

More status 
available

This flag indicates that one or more 
of the flags in the More Field Device 
Status section are set 

Information only.

Cold start This flag is set after power has been 
recycled for one communication 
transaction.

Information only.

Configuration 
changed

A change has been made to the 
CorrTran AQUA configuration.

This can be reset by pressing the 
Reset Config Changed Flag on the 
device status tab. See section 6.3 for 
more information.

Device 
malfunction

This flag indicates that one or more 
of the flags in the Device Malfunction 
section are set. 

Information only.

Table 2.  Device Status Codes Troubleshooting Guide (continued on next page)
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Device Status 
Codes

Description Troubleshooting

High localized 
corrosion 
detected

The localized corrosion rate is above 
0.3.

Information only.

Conductance out 
of range

The measured solution conductance 
is lower than 4 μS. This equals a 
conductivity of approximately 1 μS/cm 
for finger electrodes.

The CorrTran AQUA needs at least 
4 μS of solution conductance or 
solution conductivity of 1 μS/cm for full 
accuracy. This can also be an indication 
that there is too much build up on the 
surface of the electrodes and they may 
need to be cleaned or they may not be 
fully immersed in the process fluid.

Cell offset 
voltage overflow

The CorrTran AQUA has detected 
a voltage difference between the 
three electrodes which is too high to 
compensate.

Typically this is an indication that there 
is too much build up on the surface 
of the electrodes and they need to be 
cleaned or that they have exceeded 
their useful life and should be replaced.

Corrosion rate 
calculation not 
possible

The CorrTran AQUA was not able to 
get any useful data.

Check the electrodes for debris, check 
for other flags, and make sure that the 
electrodes are fully immersed.

Electrode 
balance out of 
range

Due to an extremely high unbalanced 
potential (voltage difference) of the 
electrodes, the CorrTran AQUA is 
drawing more power from the loop than 
available.

One way to deal with this problem is 
to set the loop current to a fixed value 
(max is 20 mA). This should only occur 
under very rare circumstances, where 
the corrosion rate is very small (loop 
current is approx. 4 mA) but at the 
same time there is a huge potential 
difference between the electrodes. This 
can indicate contamination of one or 
more electrodes, corrosion masking 
effects of buildup, or that one electrode 
is bent or missing from the probe.

Internal failure Hardware failure detected Replace transmitter

ADC failure ADC failure detected Replace transmitter

Memory failure Memory failure detected Replace transmitter

Table 3.  Device Status Codes Troubleshooting Guide (continued from previous page)
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13. MEASURING PRINCIPLE

Figure 35.  CorrTran AQUA Corrosion Cell 

General corrosion
Linear Polarization Resistance (LPR) is based on the fact that in a corroding electrode the 
relationship between icorr and the polarization resistance is give by the following equation:

icorr = B
Rp

 , where Rp = ∆E
∆I

 with ∆E being the applied voltage and ∆I the resulting current.

Harmonic Distortion Analysis (HDA) allows CorrTran AQUA to determine icorr without using 
the Tafel slopes (ba, bc). This is typically done by applying a low frequency sinusoidal 
voltage and determining the distance of the resulting current.

CorrTran AQUA accurately measures the general corrosion rate by implementing 
Harmonic Distortion Analysis (HDA) to improve the performance of Linear Polarization 
Resistance (LPR). A process-specific Stern-Geary voltage (Bharm) is calculated with every 
measurement cycle through HDA. This value is then implemented in the LPR corrosion 
rate calculation resulting in a highly accurate self adjusting, process specific corrosion rate 
calculation. CorrTran AQUA can measure the general corrosion rate from 0 … 1000 mpy 
(0 … 25 mmpy).

Localized Corrosion (Pitting)
Electrochemical Noise (ECN) is the method of monitoring spontaneous fluctuations 
generated at the interface of the corroding metal and process solution. As localized 
corrosion occurs, these fluctuations increase. 

The CorrTran AQUA monitors for these fluctuations on the electrode surfaces for 17 minutes. 
It then performs a statistical analysis resulting in a unitless pitting factor value between 
0 and 1. A pitting factor of nearly 0 represents no localized corrosion activity and a pitting 
factor of 1 represents high localized corrosion activity. Independent studies have revealed 
that a sustained pitting factor of greater than 0.3 is cause for concern and you should 
investigate the source of the elevated Localized Corrosion rate. For more information on 
the interpretation of localized corrosion please review our white paper: “Detecting and 
Interpreting Localized Corrosion Using CorrTran AQUA.”

Fe

Anodic
site

Cathodic
site

Fe2+

2H+

H2

Icorr 2e-





4 - 20 mA PROBE

39



CorrTran AQUA Corrosion Monitor

Conductance
Solution resistance is a measure of how easily electricity flows along a certain path through 
an electrical element. The reciprocal of the solution resistance is solution conductance. 

The CorrTran AQUA measures solution resistance in order to more accurately calculate the 
general corrosion rates. As an added feature CorrTran AQUA provides you with the solution 
conductance in units of Siemens as the tertiary variable that is not scalable. CorrTran AQUA 
requires a minimum solution conductance of 4 μS in order to provide reliable corrosion 
data. 

The solution conductance value that CorrTran AQUA provides can be used to approximate 
solution conductivity by this relationship:

Conductivity ( S
cm ) ≈ Conductance (S)

19

Solution conductivity is a function of distance. As the electrodes corrode, their 
sizes and geometry change causing this correlation to deteriorate. The CorrTran 
AQUA should not be considered as a replacement for standard conductivity 
meters.

Note
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14. APPENDIX

Electrode material guide

 Other materials are available on request.

Electrode material Key number K value UNS number
Aluminum
1100 0N 10940.96 A91100
 2024 0O 11400.51 A92024
6061 0T — A96061
7075 1O — A97075
Carbon & steel alloys
1010 0S — G10100
1018 0A 11597.63 G10180
1020 1T 11401.49 G10200
C4130 1R 11283.76 G41300
Stainless steel
1.4301 / 304 0C 11334.57 S30400
1.4307 / 304L 0D 11342.80 S30403 
1.4401 / 316 0E 11513.39 S31600
1.4404 / 316L 0F 11519.53 S31603 
1.4571 / 316Ti 1M 11382.15 S31635
1.4438 / 317L 1G 11400.62 S31703
1.4939 / 904L 1K 11287.19 N08904
Copper alloys
CDA110ETP (99.9 Cu) 0J 11686.71 C11000
CDA220 (bronze) 0P 8644.02 R50400
CDA443 (ARS AD. brass) 0M 12324.74 C44300
CDA687 (Aluminium brass) 0L 12411.53 C68700
CDA706 (Cu/Ni 90/10 0K 11513.44 C70610
CDA715 (Cu/Ni 70/30) 0I 11337.86 C71500
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